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File Type and Description

M¢ Transmission_Line_400KV_NEW_RAMCHI-CHANDWA-2_ 230401,155224543 IST,P216,4111,ERD1_13104318.cfg 12-05-2023 11:49 CFG File 2 KB

=| Transmission_Line_400KV_MEW_RAMCHI-CHAMDWA-2_ 230401,155224543 15T.P216,4111,ERD1_1319431%. dat 12-05-2023 11:49 DAT File 119 KB

/

Mainly Tw file is required for complete analysis

1. CFG-CONFIGURATION FILE

a. Station name and identification

b. Number and type of channels

c. Channel names, units, and conversion factors
d. Line frequency

e. Sample rate and number of samples at this rate
f. Date and time of first data value

g. Date and time of trigger point

h. File type

2. Dat-DATA FILE

Arranged in rows and columns Each row contains one sample point Each row contains n plus 2 entries
As many rows as needed First column is integer sample number Second column is sample time in psec
All other columns contain sample values All data values are integers An ASCII end of file mark at the end




CONFIGURATION FILE (REVISED COMTRADE)

station_pame,rec_ﬂev,rev_year<CRfLF>

NGC-1 R , 1997

TT, ##A, ##D<CR/LF>
55,23Aa, 32D

An,ch_id,ph,ccbm,uu,a,b,skew,min,max,primary,secondary,PS<CRfLF>
1,Fl1-Ia JA, A , 0.001953,0,0,-32767,32767,
2,F2-1IB ,B, /A ; 0.001953,0,0,-32767,32767,
3,F3-IC ,C, /A , 0.001953,0,0,-32767,32767,

Dn,ch id,ph, ccbm,y<CR/LF>
1,Virt Op 2 On s s .0
2,PH DIST Z1 OP .,,0

32,0ff R
1f<CR/LF>

50
nrates<CR/LF>

0

samp , endsamp<CR/LF>

0, 5680
dd/mm/yyyy,hh:mm:ss.ssssss<CR/LF>
01/08/2012,06:11:16.003865
dd/mm/yyyy,hh:mm:ss.ssssss<CR/LF>
01/08/2012,06:11:16.713704
ft<CR/LF>

BINARY

timemul t<CR/LF>

0.25




_| *configuration file.cfg - Notepad

File Edit Format View Help

B403 MAIN1,,1997

1,il1,,1,A,4.608295¢-03,0.000000e+00,0.000000e+00, - 10509, 11835
2,il2,,2,A,4.608295¢-03,0.000000e+00,0.000000e+00, -10509,11835,2 . 0000

Total number of channel 42, analogue channel 7, Digital channel 35

.000000e+03,1.000000e+00
OET93, 1. 000000e+00,5

™ CT ratio 2000,1 type, default value shown in

4

3,1L3,,3,A,4.608295¢-03,0.0000000+00,0.0000002+00, -10509,11835,2.000000e+03,1.000000e+0@, S L Secondary

4,ul1,,5,V,9.433962e-03,0.000000e+00,0.000000e+00, -10509,11835,4.000000e+05,1.100000e+02 , S

5,uL2,,6,V,9.433962¢-03,0.000000e+00,0.0000006+00, -10509,11835,4. 000000105, 1. 100000e+02 , S Description of analogue channel

6,ul3,,7,V,9.433962e-03,0.000000e+00,0.000000e+00, - 10509,11835, 4., 000000e+05,1.100000e+02, S

-

7,iEparallel,,64,A,4.608295¢-03,0.0000000+00, 0. 000000e+00 , -10509,11835,2.000000e+03, 1.000000¢+00, S
1,FltRecSta ,,,0

2,M CB RO
3,M CB YO
4,M CB BO
5,T CB RO
6,T CB YO

35,DT SEND
50.0

1000.000000, 3000
27/04]7973,05:21:51.171000

27/04/2023,05:21:51.671000

BINARY
1.0

L |

L |

- e
- e
-
Laow B v T ow TR v I 2

bl
b
]

3.4,M1/2 CRSND,,,@

J‘JJ‘@

I

—— Description of Digital channel

This is sampling frequency and number of sample. In this case sampling frequency 1000 Hz.
If zero is mention in place of sampling frequency then it means that sampling frequency is
variable not fixed

\

\ File start time
Fault start time



DATA FILE (REVISED COMTRADE)

ASCI| data format
Binary data format

n, timestamp, A, ,A, , ...., A, D;, D,, ..., D <CR/LF>

n: Sample number
timestamp: in microsecond =
(tstamp x tmult)
A.: Analog Sample values
D,: Digital Sample values




Sample relative time w.r.t file start time

How .cfg and .dat connect with
Their name must be same

.
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000 6 ¢ DO OO POEOPPOO0OEOROEOEEEOEOO®

L e e R e L e e T B s D B B e T R B e B R e B E e B T B R B R )
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Fault Calculation

Data>fault calculator>single ended

Select the channel where fault is there
manual selection

L]

i |

\ +[([=T+] Scale Title RMS InstPeak Phase In

ra

w

/\/\/\/\f\f\f\f\f\f\f\f\f\f\f\f\f\f\;’\

Knnnmﬂﬂﬂﬂ

VVVY VYV TVVY VY Y
AAAAAAAAAAAAARAAA AR

J’\ A AA N AANA J’\H ” ”
del\Fault Location Calculator
U U U U v v Riadial Line Mood I Reactance Method ]

AN i

\/ v v U U U v v v U U U U U U U U U \ v v U U U v " Channel Mumber: ‘ 3 j 2= ‘SS ‘BS = [ Positive Sequence Line Impedance ] »
| Channel Mumber: ‘ 7 j Z0= ‘ZSD ‘?S [ Zero Sequence Line Impedance |
1]
\/\/\/\/\/\/\/\/\f\/\f\/\/\/\/\/\/\ﬂ A
AR A = o
! The Fault Calculator uses a single AMS Angle
| ended algorithm. The algorithm Wi= [199411.434 |Be280 [ Voltage Phasor @ Data Bar |
| accuracy is best when the faulted
o A line is radial and the error due to IF= |2533_744 |352_435 [ Cument Phasor ( Data Bar )
LS V v V \} 1| [fault resistance and load flow is
! v substantially eliminated. 7[5 [615 [ Fault Impedance - [ Vi /11 ]]
! Please select the Yoltage and
: Current numbers from the drop down Ko = |D'987 |'1 33 [[20-211/[3°21])
1 lists. Then enter the Positive and
Megative Seq line Zloop = |130.223 |79.35 [ Radial Line Loop Impedance |
, Impedances. [Z1[1 +ka])
1
! Press "Calculate™ to run the
: Algorithm or "Refresh” to read the
\ | Moltage and Cunent Yalues at the Fresult
A i A dala bar. [FautLocation: | | 58.948 | Mies [[Im[2]/ Im[Ziop] 1100 )
1
1
1
ﬁ ﬂ [\ [= T Report Befiesh ‘ Calculate Clase
I
: Line Length = 100 Voltage Ratio = 1.4/ 1.0 Current Ratio = 1.0/ 1.0
1
1
1
ﬂ
1
1

[\ i / 708 Afem N 2743418 493475 343601 344207

1

! -

1 <ampw. Zool

! Page Duration: 770 Mil:
T T LETTY T Tavzn T Teonn T T

/\ T Tioan
7

Output: % fault distance or Fault impedance

Positive and zero sequence impedance
\ /

Voltage drop due to Iy is not seen

by A end relay. That’s why Double ended
calculation is required.

Accuracy will be better with double ended
method but needs time sync other end
DR for that.



Fault Calculation

Data>fault D

etector

D[ Qar] T RMS inoPesk  Phase I ReNd  MaPesk MinPexk
i z _"
| W4 Single Ended Fault Location
: : A BBAn
E Inputs (In Secondary Values)
! Magnitude Angle
: min...-\....-- e Zine: Im |g‘uu Line Lenglh: (0,000 Phase Selection: Intemal 5 BEAn
! LIse the Advanced bulton below to change
| k2N: (0000 000 Vnom [Voks): 0,000 the Phase Selection.
k2 IU.UUU |[lUU Inom (Amps] 1,000 Advanced
Analog Channels Outputs
L w " ;‘ 4' A W | 7w ERIRL
|\ |I '\
| (] \ | | | _
f /m P H | p | H | e o] | P B v st
“ GV VUV VUV VUV oo | | FTine
f”‘ !lﬁ fﬁ' ‘ﬂ‘ ﬂ lﬁll “wll “n“ |'”‘w ‘lr\ll ““h |‘“‘w |'\| IM: v Detected Errors and Attentions
5 || ll\ 1l }‘\ |/ ‘\ / lH III} x‘\ \‘} liI \‘? li| |'} \|l} H‘r |U} Pre Reference Bar Cycles: 4 B AdbViem
U VR E Post Reference Bar Cycles: IW—
CAAADNAAAA AN ﬁ f"\
'\H\URUR\\U|\||‘|‘\|\‘ “'
E‘ \f \’ |’ |f WH MHHHHI Open ‘ Save | Save s | Hew Spat | Piit | Show Help | Close |42 B
Vo ! VYV VYV YV YV VY
File: Untitled Start Samp: 1 |Total Samps: 289
7 s Eparlel B4 0180 0290  83%08° (008 004 0% 021 A ZEAkm
(= R LY L L RLE ILE KT LK L BT TN

Positive and zero sequence impedance

O In this method automatically fault time
is detected. No need to select the data
by moving the pointer

[ Fault distance detected
1 Faulted Phase detected



Time Adjustment

Data>Adjust file times

1| 4.02952E6 Viom || YT 238674514

Enter the adjustment time for the active file.

Ok

Active File's Start Time: [06:56:09_ 775000
* Add Time (" Subtract Time

Hourg: |00 Minutes: |00 Seconds: |00 Millizeconds: | 000

Adjuzt Open Time:

[ Apply the Adjust file time uzing the above time adjustment for all
COMTRADE  Files

44567.3 Atcm IC 178,397

Canicel

336812.500

]

-209.950

123200

g33®

9321

166.378°

316.86E°

O During a disturbance involving multiple
location we need to sync the DR time. From
PMU we
can decide the start time, then for each file
we may add or minus required time to bring
all of them in same time frame

O For international line with different time
zone also we can do this adjustment. So that
we can analyse them together.



Channel >Software analogue channel

W¥ Software Analog Channels for: CAUSERS\SAIBAL\DOWNLOADS\DR ANALYSIS\DR ANALYSIS\LR\TYPE-1\230427,0.. X

Station:  B403_MAINT Device ID: 250 oK
Use the Operators Drop Down List to Select the Fast SACs. Once Selected the SAC equation will be Displayed. Cancel
The Channel Mumbers will be Populated with the first 3 Marked Channels in the Data Display. =anc
Chan Titles Operatars Apply
[ 8 P /+B@120/+8#@-120/"3/u=v/
A A N
3 I{SoﬂJve Channel} | \

—
L=

|{S nﬂwia Channel}
|{S oftwark Channel}

11

|
T

|
|
12
13
14 |{Software Channel}
15
16
L

|
| {Software Channel} | X Clear Al |
I{S oftware Channel} I
|Scftware Channel} I Chan Titles Operators
e Modified 8 IInegatiue +1/+2@-120/+ 321204 " 3=/

9 |{Software Channel}

[ 1n 110 athvimrm Pl il I

ALl




Harmonics

W 230427,052151671,IST,P144,4031,ER01_13353615.dat - 27/04/2023 - 05:21:51.671 - Secondary - (Peak Type)

CH [{] « | | o [{JaT+] Tite RMS  InstPesk  Phase  Instval  Refval  MaxPesk  MinP
1 : i1 1 0137 0235  174982° 0161 0134 0235 020
2 iL2 2 0073 0138 628 0003 0028 0152 015
. : W Harmonics — O
3 b g4 Channel Name: | (4) ul1 5 Sampt: 501 & ||ﬁ%, ﬁ| TRl
: h % of Fundamental
o - llr-\ l;-\ l,r-\ llr-\ llr-\ 0 1 2 4 s & 7 8 9 10
[I% By default 1 channel Harmomcs is ] \) \/ 1 o
shown , to see harmonics of other A oo
AN ("; || channel select that channel '\1'\ I("' (" (' f] e
'L"I l'L'll ’k'll l'u'l VYV V VY Y VYYYYYYYYYY VYWY ".,’ 'J \ Jl 'Jl 'Jl 2“:
|I I||| |l| |l| |l| |l| |l| |l| ll\ ll”l I|'1 I|'1 fi |'1 |'1 |'1 |'1 |'1 |”I '”| '”| "| "| /"l ‘ﬁll [:ﬁl fl f' =
) | | | | | | | | . | L
EI '|} "| M/ U "| /l ”L Hl ”l ” \} U M \u/ "u/ U \| / ‘J \| |f \Il }llll {ll |F ||| |I }llll {ll |+'||| "I,}'..'Il 1..} True AMS: 63870 Felculaled RMS: 63853 THD: 0.373% |
H' Vo i H' H' H' H' "
7 ._,__ e | iEparallel 64 0174 0327  -131.384° 0083 0014 0327 022

View >Harmonics Table




¥¢ Harmonic Analysis Report

Settings:

Enter the Settings Information below for filtering the Harmonic data that will be reported in

the Harmonic &nalysis Report.

Report Harmonics Above: |1

% of Fundemental.

lgnore DFT Currents Below: I‘] 0

Amps

lgnore DFT Vaoltages Befow: |1 0

Leave the Currery/ and Valtage fields blark or set ta 0 to disable the checks.

Volts

Bun Report

Minimum % of Fundamental
which needs to be reported

Start of Harmonics —|

Start Date && Time:
End Date && Time:

File Duration: 2
Sampling Frequency:
Line Fregquency:

Show Harmonics Above:
Ignore Currents Below:
Ignore Voltages Below:

(4) ulLl S5V
Date & Time

{(3) uLz & V
Date & Time

(6) uLs 7 V
Date & Time

27/04/2023 05:2

27/04/2023 05:

21:

00 27/04/2023 05:21:52
0 27/04/2023 05: :
02 27/04/2023 05:21:

03 27/04/2023 05:
04 27/04/2023 05:21:
05 27/04/2023 05:

Data>Harmonics Analysis report

The difference between Harmonics table and this report is that

in previous method the analysis is done for a particular time where
the pointer is there.

In this method complete analysis of the total time window is done
for all the channel

M File: C:\Users\Saibal\AppData\Local\Wavewin\upgrades-list.txt

Station: B403 MAIN1
Device: 4031
File Name: C:\USERS\SAIBAL\DOWNLCADS\DR ANALYSIS\DR ANALYSIS\LR\TYPE-1\230427,052151671,I5T,P144,4031,ERO1 13353€l15.dat
File Size: 84000 Bytes
Prefault Time: 27/04/2023 05:21:51.171000
Trigger Time: 27/04/2023 05:21:51.671000
Save Time: 05-15-2023 16:15:38
27/04/2023

05:21:51.171000
05:21:54.170000

- S99 Mils(s)

000, 1000.000 Microsecond Rate

Duration of harmonics

Sample # Magnitude Fundemental

:53.846000 2676 90.390 90.390
Sample # Magnitude Fundemental

52.341000 1171 90.961 90.961
Sample # Magnitude Fundemental
1629 47.878 85.148
1638 97.602 97.602 0
1623 39.419%9 50.839 T77.537
1625 22.023 72.418 30.411
lez22 14.403 38.832 37.092

1624 12.100 62.529 19.350



Generate SOE from Digital Channel

Open wavewin.exe and then open the desired folder where DRs are there. Window will look like below:

¥ Wavewin-SE H.G6 -
Files Edit Sot Mark Options Drivers Query Window Help
Exit System = 0 O Back @ Fles 05242023 06:0 S 2 . | h d f 1 | d 1 h
— o % g tep-2: select the .dat file ana in the top menu
Fies: @ 4 & ¢ & 0 P W B
W4 CA\Users S\ Downloads\ DR analysis\OR analysis\Line\ SLowine-1 E=R ba r.
Folders x File Name F-Type Size Trigger Date Trigger Time Save Date Save Time Driver TCode Substation
3 ATCTIC Repol Odsha I » _ 0 06 /20208 07:00:2 RoolDi O SOE |
) ATCTTC . . 0 05 /2472023 07 :00:22 Previous Dit pt I O n > re p O rt> I St
-0 base case [230427.052151673]5T.P144 4032 ERDT_13353619.dat dat 99259 D4/27 /2023 05:21:51 673 05/15/2023 16:15:36 Comhade 15T P44
-0 Base cases 3 dat B0 042 05:21 50 671 05/15/2023 16 :15:3 Comhede IST  Pldd
[#-0) base cases final clg 1433 0472 05:21 ;50 671 0571572023 16 :15:38 ASCI ST P44

e - | This will give a SOE list based on the digital
A3 Bh_1_gi42

S signal and make analysis easy

[]:8 s\;cku?I?I reports_080420;

-J) casecade tree

[+ conferencedatex-emplate_

@) Data
15Tt W% Sequence of Events List: C:\Users\Saibal\AppData\Local\Wavewin\SOE LIST.CSV
53335 Substation Device State Trigger Date - Trigger Time Ch... Channel Title
(-2 Day 89410
S oc o [EINAGURI_SS | 1 A 21/ 047 2023 21: 29: 28. 899096 27  MAIN-1_Z3_START
3 ittt 1] BINAGURI_SS 1 A 217 047 2023 21: 29: 28. 947410 26 MAIN-1_Z2 START
B o P’ BINAGURI_SS 1 217 047 2023 21 29: 29 152328 26 MAIN-1_Z2_START
Ay BINAGURI_SS 1 A 21/ 047 2023 21: 29: 29. 168988 26  MAIN-1_Z2_START
&3 ORIl BINAGURI_SS 1 A 21/ 047 2023 21: 29: 29. 378904 16 23 3PH GRP-8 OP
e BINAGURI_SS 1 A 21/ 047 2023 21: 29: 29. 378304 15  R223PH GRP-AOP
58D DR ansis BINAGURI_SS 1 A 217 047 2023 21: 29: 29. 378904 7  MAIN-I-TRIP
83 Boken Conct BINAGURI_SS 1 A 21/ 04/ 2023 21: 29: 29, 378904 4 MAIN-1_Z2_OPTD
i BINAGURI_SS 1 A 21/ 047 2023 21: 29: 29. 407226 11 MCB_AR_LOCKOUT
b e BINAGURI_SS 1 A 21/ 047 2023 21: 29: 29. 418888 36  L14 TCB_YPH_OPEN
-3 Ly BINAGURI_SS 1 A 217 047 2023 21: 29: 29. 418888 35  L13TCB_RPH_OPEN
Lo BINAGURI_SS 1 A 217 04/ 2023 21: 29: 29. 417222 37 LIS TCE_BPH_OPEN
P - : BINAGURI_SS 1 A 21/ 04/ 2023 21: 29: 29. 417222 3 L3MCB_BPH_OPEN
BINAGURI_SS 1 A 21/ 047 2023 21: 29: 29. 417222 2 L2MCB_YPH_OPEN
BINAGURI_SS 1 A 21/ 047 2023 21: 29: 29. 417222 1 L1 MCB_RPH_OPEN
BINAGLIRI_SS 1 A 217 047 2023 21: 29: 29, 423886 8  L10M2_PROTW_OPT
BIN S 1 21/ 047 2023 21: 29: 29. 433882 27  MAIN-1_Z3_START
BIN S5 1 N 21/ 04/ 2023 21: 29: 29 433882 26 MAIN-_Z2 START
B 55 1 21/ 047 2023 21: 29: 29. 433882 16 R233PH GRP-BOP
BIN 55 1 I 21/ 047 2023 21: 29: 29. 433882 15 R223PHGRP-AOP
BIN g 1 217 047 2023 21: 29: 29. 433882 4 MaIN-1_Z2_0PTD
BIN 5 1 21/ 047 2023 21: 29: 29. 437214 8 L10 M2_PROTN_OPT
BIN 5 1 21/ 047 2023 21 23: 29. 458872 7 MAIN--TRIP




Anti theft/ldle charged line/AR successful from one end only

Type-1: In such cases line without any LR will remain charged from one end and charging current will flow. So Angle
between the voltage and current will be 90 degree.

Type-2: However there are few special consideration for lines where L/R is there. These are as follows:
1. Case 1: Current used in distance protection = Line current — LR current
2. Case 2: Current used in distance protection = Line current

These two case are very tricky and proper analysis is required.

ILme = +1
Lme reactor™ Icharging
A end |_. ._| B end A end ._| B end
é Ireactor é IReactor

Case -1 Ca se -1
Irelay — ILine _ Ireactor = _Ireactor Irelay — ILine _ Ireactor = lyeactor™ Icharging — Ireactor
= Ichargin
Case -2 gmng
_ _ Case -2
Irelay - ILine =0

Irelay = Ipine = Icharging"' Lreactor
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Case-1: Line has L/R and AR successful from only One end and LR current is subtracted from Line current in Distance
protection:

| at this point lags V by 90 degree if A end is open

\ Also it is important to check value of current:
A?F- Charging MVAR B end 1. If line charged from A end then current =only
é 81 MVAR charring current i.e 81 MVAR
57 MVAR 2. If line charged from B end then current= reactor
DR of this location \Reacmr — current i.e 57 MVAR

CH [4]| « =[] Tile  RMS [o]x]

e = - o
: ||||ii|||i'||||i'||||i'||||i'||||l'||||i'||||i'||||i'||||i'||||i'||||i'||||i'||||i'|‘||i§?||||i'||||i'||||l'||||iI||||II||||II||||II|‘||II|‘||II|‘||II|||||I|‘||II|‘||II|‘|||I|‘|‘|I|‘|‘|I|‘|‘|I|‘|‘|I|‘|‘|I|‘|‘|I|‘|‘|I|‘|‘|I|||‘|I|‘|‘|I|‘|‘|I|‘||||||||||I||||||||||||‘|‘|ll||‘|l|||‘|||||‘||I||‘||I||‘|ll||‘|ll|l‘|; ||||||‘||I||‘|||||‘||I||‘|ll||‘|l|||‘|||||‘||I||‘|ll||||ll|l||| S -
.|i-l-||}|-I'l}l}i'l'l}l}i'l'l}l}i'l'l}l}i'l'l}l}i'I'l}l}i'l'l}l}i'l'|||}i'l'f}i'l'l}l}i'l'l}l"'l}lk"'I}lli"?li"'||||,'I'||||,"'||||."'.||||'I'||||I"'|||I|'I'|}||I'I'I|I||'I'||||I"'|||l|'I'||||,'I'||||,'I" AN A "Jl}l'l'|||||'|'|}|||'|'|’||I'|'|’|||'|'Illll'l'lllil'l'l’lil'lél l‘|’|||'|'I’||I'|'|’||I'|'|’||I'|'||||I'|'I}||I'|'I’l||'|'|’||I'I'|’||I'I'|’|’|'I'Jl I — 150 0
‘ ~—--—f~--- i »»A'}fi-lll}'-l-l}ll-l-l}l}'-i-l}j’-l-lll IL it R — PR
T A omotherend | S i "
B [ ”‘?"“W’““’“’““““““““““““"“““J""‘""”””””' Here IA leads VA by 90 degree as in distance
5 relay the reactor current is subtracted and at =
7 ”WWMWUWUU’UU’UWU’L{UVWWWWWW | thisxllocation only reactor current is flowing no
8 : F‘JUWWWW“WWVWWUWLL”“m Ii?e current that’s why phase opposition took | 2 -
e | place.




Case-2: Line has L/R and AR successful from only One end and LR current is not subtracted from Line current in Distance
protection:

| at this point leads V by 90 degree as MVAR,cqctor< MVAR harging

A end \ -_I Also it is important to check value of current:
Charging MVAR B end 1. If line charged from A end then current =Charging
57 MVAR 81 MVAR + Reactor current
. . Reactor —— 2. Ifline charged from B end then current=0
] DR of this location - = EEE] e A
i | .
| ¥ it AL rmenieeemenneennd MU .
I e 1 i A
E : - A
. I|||lll|||lll|||ill|||'II|||l|I|||'II|||'II|||lII|||lII|||IP:EI|||'II|||FII|||'|I|||'|I|||lII|||l|I|||'II|||l|I|||lII|||'II|||'II|||III|||FII|||III|||'|I|||'|I|||l|I|||'II|||l|I|||l|I|||'|I|||'II|||lll|||ill|||illl||'|I |||'|I|||'|I|||rhl|.|rll|.|rll|.|rll|.|rll|.|rll|.|rll|.|rll|.|r:| Ll|.|rll|.|rll|.|rll|.|rll|.|rll|.|rll|.|rll|.|rll|.|rll|.|rll|.|rll|.|rll|.|rll|.|rll dEl | RN
: | 150
AR EREAEARRREAR AR ARERARERRERAEALRRERAEERERERAEAREANE AL ERRRRRRRRARRAREARARRAREARRRRARARRRRAREARRRREREARRA|
g AT o zessonsae
: Y
) R ;_Hpuumllhllful ][1[|||II||]II|!II|III WL B ' _\
N Hﬂguﬁ'rlﬂlujlf.”luj{ll'Jli"Jlil'Jlll'Jilﬂjli']{H i |I|J| ﬂhujilul{||"|iliulHluJliulﬂll-“"ili" ||Hi|H||| lllw WWT B
: ' 180 0
5 ~ n['nl E I 71.020
t: A/R from other end ( |
[ -NAMM-\MMAMMMH:J\ s : =] B2 4RN £
Here IA leads VA by 90 degree as in distance
e relay only line current is taken and as charging
: current > reactor current that’s why the overall
l ﬂf\,\, """"""" current polarity is capacitive 240 _ 00
' 1240 :-:ln-s ' 1240 48] 7 Tsed T1200 "m:' 71680 11530 !! |'| - NS _




Identify Sending and Receiving end

—T T amn u Taan u T L Ton u Tan u g on B =)

o | : S —— - e

| i 1986acn || IAPH  1m9sa 280083 0

5 AAAMANAAAAAARMAAAANA N e Lo e ol = =
.| Angle between Channel 1 and 5i.e VA

j ] and IA is <90 degree means Power is

flowing out from this node-sending

n Od e 240 300
. TUUUUUUUUUUUUUUUUUUUN TTIEaT w7 £ RTARE:] TR . 2




Identify Sending and Receiving end

270

Py Sle =
CH 4] « | . . VR[=T=] Scale Title RS InstPeak Phasars NEE
‘1?“ ”‘iy"u" % 1454.4 & fcm 16 242827 -353.591 0. 0
2 P': {‘\ {‘\ 1454.4 Adem B 260.148 36464 -1
I
A , _—
; Angle between Channel 1 and 5i.e VA

AAAAAAAAARARAARARAAAAARAANN : ;
S| and 1A is >90 degree means Power is T

UUUUUUUUUUUUUUUH UUUUUUUUUU 'JE'J'|.|'J'J'J'J'J'J'J'J'J'J'J'J'J'J'J'J'J'J'J'J'J'J'JU'J'J'J'JU'J'J'J'JU'J'J'J'JU'J'J'J'JU'J'J .
. _i Lﬂﬂﬂﬂﬂﬂﬂﬂﬁﬁﬁﬂﬂﬁﬂﬂﬂﬁﬂﬁﬁﬁﬁﬁﬁﬁﬁﬂﬁﬁﬁﬂﬂﬁﬁﬁﬂﬁﬁﬁﬁﬂﬁﬁﬁ AR (I I —

A R A A R A R R R

Tron T T7rn T Taon
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Slow Fault Building Mechanism

MK

Fault start at Voltage Peak

O During Slow fault building mechanism
Like vegetation fault, conductor snapping
etc Fault take place at the voltage peak.

dV/dt very fast as compared to dx/dt

Aendh \ B end

dv/dx when exceed
insulation strength of
air, arc is formed

In Vegetation fault higher resistance
is involved
so V & | angle is lesser compared to
line angle



Vegetation fault

. _1 Xy
Line Angle= tan~1 =2
line
i« | EE] sede IndPeak  Phase  Instid_ [o]x] Phascn TR
N " 8
H{ | fg"l “\I‘I.HI';,’I 1 f JF‘H_\_\N! \ ’I'\f!f1;“fﬂl'_\,4'lll‘ j '|‘l.'| }I‘fif‘;lfif'.\f \,j.’. hl:,'ﬂljjn'\:‘vf'\'_\ll‘_‘ \,_\I,"‘I {I .‘I;f :‘l eovien | ke TmSF TR - 120 : "
NANAAAAAAAAANANAD AN NAA A AR . .
= ';“.f".“"/".”/ TV '.L/".:_J/ 'i,'("'{}”l.‘-"‘(ﬁ"'/ ",("'ﬂ"m‘u '\f'\-',f 'n'f‘\',-f[‘i\ﬂ;{'t;" MY || bt | Angle between Voltage and
AR AR A AL AN AN A iy Current much less than the line
| ‘ } ". --h‘ " -|-“| 4 ‘.’I‘ [ Nlasanvem | 757700 10609 251%00 1 . .
Y U U e angle. In a 400 kV line angle is
k AL around 80 to 84 degree,
""ﬂ'}-“”,-r""..'i I'\ ]'-ﬂ‘-»‘!l' ']\ Il |'| 118918 0V femn 1 L 3 . N
VRV A O However it the above fault it is seen
‘ % ” that the angle between V and |
| | | is only 11 degree. Indicating
il High resistance in the fault loop.
L '-“\‘,' i { / :\, 190154k | 145 o7 . .
U O This could be due to Vegetation fault
\ 210
S s P o é M\f\f'\/\wwww 190154k 49175 73180 ER 300 3
il
\/\W/\(w\f\-mwm— WSA | TATE M A0ER 8




Another type of slow fault building mechanism is some solid fault due to kite thread, jumper snaping ect.

In this type resistance of the fault loop is less

W 230427,052151671,15T,P144,4031,ER01_13353615.dat - 27/04/2023 - 05:21:51.671 - Secondary - (Peak Type) =2 R~
CH Eﬂ = InstPeak  Phas @ Phasors NE G
g Angle between voltage and current cIose o

T T to line angle as no major resistive path is |HEE———— 12 0
| involved.
o A : In this case the angle is 76 degree i.e el I }
2 close to line angle
[3 o R J: \ / \l. f L33 2277 3608 7LII0°
lu;i k; l'u'
O T O A A RN AT AT A f NN \\\_
| |I foodef \ | \ / \ f \ f \ f '| . .Il: o f '. f '. f |I { |I f '. | '. | '. | || | |I | | | A A O O A 0 O O O U | YR 63610 89509 -118.830|| 1gp ¥ > 0
R RTATREATRTRTRY ‘;E'l WA A A A '| |' '| |' g |z e B4126 90406  121.087°
‘ "| |'n'| I'ﬁ'l I’h"| A ,’;"I AR 210 330
6 '\ ! \ {I } { |} { - { |} 'il |} 'il |} 'il ;'im:i, | | f et imtiong S i 13 7 54228 76534  0.000°
J | |k| |U| |U| In‘.-'l I'|..-'I I'|.,-'I I'l.-"l é:'l-'ll 'l."l
7 "'Hf“’ﬁ'm “““““““““ Eparallel 64 0132 0.313 108.375° 240 300
— T 190 " I '!}'\'s 5 " 100 " 7980 ° T200 ° 1250 ° T300 Tash ™ = || PeocOurston Séowists) owomiests)




Lightening Fault

O = In lightening fault, generally back flashover between tower
| and live phase wire took place. No resistive path is involved
hence Fault Angle is close to Line angle.

I 1
I-.,.- HI
sy
=
Yt T
. Channel Name: | (6] 1B samptt 712 & [[30 2 Gw | on-
Fault at any point on Voltage waveform
. A ' % of Fundamental
0 1 2 3 4 3 il T & L 10
IEEI“.-{:E
; 100%)
80%]
E-EI".-{:; i . . . ' i ' '
40%] T3%| 53% | 37% | 25% | 1.6% | 1.4%| 1.5%| 1.6%
EEI".'&; . . . | \ | | |
.
I -
True AMS: 12348.918 Calculated RMS: 9426 164 THD: 15.338%

High DC component, Fault can occur at any point in the
voltage wave form



Secondary Arc Phenomena

¥# Harmonics

Channel Mame: | [B] ul3 7

Samp: 787

=i

=
[30 2] &l G

-

% of Fundamental

CHT4« T

AT~

/ Primary arc extinct here

oo AR AR
ARV VYTV

Channel Mame: | [B] ul3 7

Secondary arc extinct here
that’s why wave form become

B
i

| F 4 F | rF

F 4 r . r

Calculated RS 31439 THD: 38.602%

Sampt: 1135

- O
21 EsciFInrET

% of Fundamental

7 & G 10

sinusoidal again

True RMS: 14.453

Distorted waveform , High Harmonics content during Secondary arc period

Calculated BMS: 14,466

2l



Signature of Line after Tripping Where L/R is present

¥ RLIWR21M22023010337b.dat - 03/01/2023 - 06:14:15.199 - Primary - (Peak Type)
oH [« | +[R[=15]
1
I :
1
1

3 phase tripping

2 = E

Lines which are shunt compensated have
typical voltage waveform like this even after three
phase tripping from both end.

Typical Waveform after
1 tripping and with L/R
present

The frequency of these waveform depends on the
percentage of compensation.

[==1

1
240 ) T510 ) ) ) T850 ) 71020 | Tiisg " I Tis3d T Ti706 T Tig7d "

[T p—
_,:__;Doomt_nm—l[|

e |




Broken Conductor

R — | .
= Tlowestsagging height -/ When a conductor snapping
s happens, it takes almost 0.6 sec
E to 1 sec for touching other phase
oy or ground and develop fault.
h==(g.t?) >t = \/2:“ — /21’5-6 — 1.06s Using this signature it can
2 g 9.8

reliably decided conductor
| snapping event by system
Detection method operator and line charging

12 / 11 broken-conductor detection method decision can be taken

VO and V2 angle
VO and V2 magnitude
Impedance based detection

B w N e



Case study: Tripping of 220 kV line on 30-11-2022 at 05:07 hrs

CH[A] « | rf=1~] Scale Title RS
—-=- : 1231440 Afem || FTHA A £3.124
2 : il 1231440 Afem || F24B B £2.245
3 ; 3 ‘, h 1231440 /e || FHCE B0.458
4 ; : 1231440 A/em || FHGG 1172
5 ' A N ATPRIZEE Viem || FEVAA 131474.366
g [AAAAAARAAALAAAARALAAAR A / '. ATPRIZEEV/em || FEVB B 133617.703
7 AR AR ARG ARAR AL ¢ . : e ATPRIZERViom || FPYCC 131380694
g fm o A M — ™/ — — —————————— Fau|t Created here 4T7BIZEEV/em || FEVN N 106,508
g COﬂdUCtOF Snapped 123144 0870m || SRC1 laRMS _ 62551
10 Ir 1231440 &/em || SR b AMS _ £2.103
11 :r 1231440 &/em || SR 1o AMS _ 59,766
12 . . ' . . 1231440 &/cm || SR In AMS _ 0.000
e — This window is useful for broken conductor detection || . .. [ 00 e
4 [ ] analysis T734.0 ke SRC WhaRMS 193.765
e — e | sraa0kwen || SRCT VegRMs | 131533
16 i FM0KYem || SRCT ViRMS _ 0.000
S - e u“‘f““’ ............................................................................................................................ e || SRR bR, | s
O P r .......... ................. FM0Kem || SRCT VbeRMS | 230347
ol ;W ............................................................................................................................ 70kven || SRCT VeaRMs_ 227148
9] [t ; ......... .................................................................................................................................................. B09.4 H/om Tiacking Frequency_ 49.930
21 : I—L* 3.17039E9 Myser| SRCT P _ 24,609
2 i —r ‘ﬁ_‘H 351591E9 Mv/em|| SRC1 0 0,234

On 30t Nov 2022 220 kV line tripped due to Y-B phase fault as Y phase conductor snapped on B phase.



Case study: Tripping of 220 kV line on 30-11-2022 at 05:07 hrs
* |12 /11 broken-conductor detection method- Gaya end DR:

CH[4 <] M=) Title RMS CH 4] «| NDE Tille AMS
. - . -
1 ' | |

FlI4 A 63182 1 : FIAA 60712
Just before condudtor snap all J Just after conducto:r snap |
three phase is carr;\“ung 61 Amp || e e : and before it touches | FiB 8 7.006
and I1is also 61 Amp and 12is 5 § ground 12 is 19.57 Amp and
AmMp 11 is 38 Amp |

F3ICC 60,625 3 FHCC 55,618

\§

1
A
I

n §1.674 23

2/11>50% | \

12 5099 o JW

T AR AL SR L\ I ST Aj_m_s T Conductor Snap detected W Tem e T en A e T Tam T Jows Vi




Continue..

» After the conductor is snapped and before it touched earthed object the current

flowing in the broken conductor is charging current and led voltage by 90 degree.

This also confirms conductor snapping.

a0

- ' ® Phasor|2 is current and phasor 6 is phase voltage

150 » It can be seen that
current and voltage is

having 180 degree prior

to conductor break and
as soon as it is broken the
current is leading voltage

- by 90 degree 210

50 &

r..\,
=

210

180 degree

240
240 300

270

90

B0

270

90 degree

300

v

30

330

After conductor snap

Prior to conductor snap




Case study: Tripping of 220 kV line on 30-11-2022 at 05:07 hrs

* VO and V2 angle:

120

150

180

210

240

30

20

270

300

330

150

210

120

Angle between VO and V2 at two
end is of opposite sign

amp: 1

End 1

240

30

60

30

330

V 2 300

270

End 2




Generator Relay

CH 3]« | |

vA[<]=

Iﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂnﬂﬁﬂﬂﬂﬂﬁﬂﬂﬂf'\f'\f\ﬂnnﬂr\ AT A R

A A AAAAALAA

R AR A AT R A A A A A A TR A A A

A A AN AN AN AN A AN A s N N W AN AW AW AW AW AW AW LW A

AR AR TAT

LY VIRV IRV VIR VIR VIRV VR A R VY VYR VRV ARV Vv

VY YY
(‘\(.\(\[\ﬂﬂmﬂﬂﬂﬂﬂﬂﬁﬂﬂﬂﬂﬂﬁﬂﬂnnnr\r\ﬂ\f\f\ﬂﬂf’\f’\f\f\r\n

AAAAALA LA AN

VYV VYTV VYUYV VRV VR

VAV VSV

AR TR TR TATRY

ook ocnnnnnnnininn hanannnananAAAAAAANANAN LA AAAA "

VPV

AR R AR R A AR TR TR R A R R TR A

Generator see the fault in R-Y phase as

GT is there in between

Delta-Star

Line Series By Time

—— /hmmICTbbmof AN
Feserve Transformer % /

Dhevice Ty e B, Subsravionid KORAM_ D, Devicelr

In Grid side single phase R-E fault

F Flesen 2o i




Transformer Differential Relay

"
CH[4] 4| =11 Soale Title FiM5
*
R, | 299283 80em | a1 518 149786
Y | 299283 80em | M1 519 151358
o, || 399283 42em || iCM1 B20 145.431
o 902 4m || IOM1 521 5294
T | 399zE a8 em | M2 522 280332
Ao | 399zE98sem | M2 523 280815
. 33926 940m || M2 524 244.088
g 33926.94/%m || J0M2 525 17143
: 33926.94/%m || i%1 538 0200
A 21568866 V/em || v 5 130426, 954
S 2 15688E6 V/em || vB 6 131438.452
g 2 15688EE V/em || T 7 130631 576
; i 21RESSERV/em || vi-cale B4 BOS19
|
14 ; 1 77.21/em IDiff4 182 0,000
: ‘
15 ; 77.21/em IDif8 183 0.000
16 : 77.21/em IDFC 184 0.000
17T —H—E— .................................................................................................................... 772 1/em IRest4 195 1.166
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- — |
gl — AT R B P, ||-p 2000 Freed 986 | 1950
B I
SRR
19| ——— R IR U Pl Fles 67 | 1000
1 I

K2 slope

| diff

K1 slope

| Reset

N
Lpn_aiff = 2 Iy
n=1

N is number of port

N
Iph_Bias = z |Iph|
n=1

This is out side fault that’s why I, 4ir¢ =0
However I, piqs is high.
But no differential operation
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Current from This end

very less.

During fault No significant increase in current
from the End where only RE is Connected
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Tripping in RE Complex

This is typical signature,
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This field is evolving and lot to learn yet
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